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Introduction 

 

Welcome to the P1 Strategy Architect! This high-performance suite of tools provides a quick and efficient 

method of generating robust trading strategies. The software utilizes the innovative P1 Strategy along 

with a genetic algorithm to create the ultimate trading system for any market. It works entirely within the 

TradeStation environment, so there is no need to export data or do any processing outside of your 

TradeStation workspace. 

 

 

In trading, one size does not fit all. The P1 Strategy Architect enables you to develop unique strategies to 

fit your markets, trading style, and risk tolerances. Using a simple user interface and standard 

TradeStation charts, the P1 Strategy Architect employs artificial intelligence (AI) to search millions of 

combinations to find only the strategies that meet specific, user-defined criteria. You do not need to learn 

or develop any specific technical analysis or trade logic to use the software; the P1 Strategy Architect AI 

searches for ideal trade entries and money management, choosing the best combination of parameters to 

create profitable strategy models. To avoid curve fitting (creating a strategy that only works on a specific 

range of historical data), P1 strategies can be developed with varying amounts of out-of-sample data and 

easily saved to a format used in the Walk Forward Optimizer for further analysis. 

 

 

The heart this software is the P1 Strategy. This strategy combines a low latency waveform filter with 

several market-specific parameters designed to create realistic short-term trading systems. The strategy 

can be set for either day trading (all trades close at end of session) or swing trading (trades over multiple 

days or weeks) and works with all time-based or volume intervals, including intraday, daily, and weekly 

charts. The strategy creates trading signals by applying one of twenty different waveshapes (with varying 

wavelengths) to price and volume data, then combining two of these waveshapes together and filtering 

the results to create signals. The figure below illustrates how raw price data converts into trading signals. 

 

 

 

 

 

The concepts involved in P1 wave filtering are analogous to audio processing where certain frequencies 

can be isolated or enhanced using high-pass, low-pass, or band-pass filtering. By combining two different 

waveshapes into the filter, the strategy isolates changes in price or volume that lead to high probability 

market moves. The software selects the optimal waveshapes and wavelengths for a given market and 

then applies the wave filter to cut out extraneous market noise, providing clear buy and sell signals. 
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Workflow 
 

It’s important to understand the process for developing and evaluating systems with the P1 Strategy 

Architect. As the name “architect” implies, the goal is for the software to design trading strategies based 

on the desired performance outcome. For instance, instead of deciding which waveforms or wavelengths 

to use (the AI decides that), you can define a range of key performance metrics, such as profit factor, 

minimum average trade, and/or a maximum drawdown to describe the overall outcome of the strategy. 

As an example, imagine a Formula 1 Grand Prix where instead of competing, a race car driver simply 

decides what their final placement should be, then turns it over to a computerized car. The car creates a 

specific strategy for the race, considering vehicle setup, track layout, and weather conditions, then 

executes that race strategy (drives the race) to achieve the optimal result. This is how the P1 Strategy 

Architect approaches trading. To begin working with the P1 Strategy Architect, you define the WHAT, 

WHEN, WHY, and HOW the strategy should perform, then instruct the P1 Strategy Architect to search for 

that strategy. Setting up a search is generally a quick process involving the following steps: 

 

Step 1 – Decide WHAT to trade 

Load a TradeStation chart with the symbol, interval, and amount of historical data to build the 

strategy. 

 

Step 2 – Choose WHEN to trade 

Use the P1 App’s checkboxes and dropdown menus to select the trade duration, time of day to 

trade, number of days to trade, and the maximum amount of risk per trade.  

 

Step 3 – Establish WHY to take trades 

Define the performance criteria for a strategy using the P1 App; this includes selecting the main 

fitness function for the strategy (such as Net Profit) and filtering out strategies that do not meet a 

user-defined profit factor, minimum trade number, maximum drawdown, or average trade amount. 

 

Step 4 – Define HOW the AI will search 

Control the genetic search operators or allow the app to specify a standard search algorithm. 

  
 

Step 5 – Click the                   button to build strategies based on steps 1 through 4. 

 

 

Once a search has begun, it may take some time to complete depending on the amount of data and your 

computer speed. These next steps outline the process of reviewing and selecting the best strategies 

following a successful search: 

 

Step 6 – Select the best strategy 

When the search is complete, a list of strategies meeting the performance criteria from step 3 

appears. You can choose a particular strategy, save the complete list, or send the results to the 

TradeStation Walk Forward Optimizer for further review. The strategy is defined by the unique list 

of input parameters. 

 
 

Step 7 – Trade the strategy 

Simply click a couple checkboxes within the chart to enable automated trading of the P1 strategy 

that was created in the steps above. NOTE: it is always recommended to thoroughly evaluate a 

strategy before trading with a live account; please see read the Disclaimer at the end of this 

guide. 
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Orientation 
 

 

 

 

The P1 Strategy Architect Search engine is a combination of a TradeStation 10 Trading App and a Chart 

Analysis Window (with the strategy “-P1 Strategy Architect” added; a dash before the strategy name 

ensures it appears at the top of your program list). These windows are symbol linked together to pass 

data back and forth between each application. The overall workspace consists of four main parts or 

modules, each with a different functionality. 

 
A – Chart Analysis Window 

Use the Chart Analysis Window to select symbols, choose intervals, and load data, just as you would in a 

regular TradeStation Chart. The chart type and appearance can be customized within the chart settings 

menu. This is a standard TradeStation Chart Analysis Window; the strategy “-P1 Strategy Architect” adds 

the Strategy Analysis List (C) and Select Performance Module (D) to the chart. 

 
B – Strategy Search App  

This module sets up the search criteria with a combination of dropdown menus and checkboxes. Once set 

up, the action buttons trigger the search and updates the search progress.  

 
C – Strategy Analysis List 

When s search has completed, this displays a list of all strategies that meet the search criteria and filters. 

The Chart Analysis Window (A) and Selected Performance Module (D) are both updated when you click 

the ‘#’ column to select a strategy. Strategies can also be sorted by any of the column headings to 

determine the best selection.  

 
D – Selected Performance Module 

This provides a concise performance analysis for the selected strategy from the Strategy Analysis Model 

(C) along with an equity chart that overlays the ‘Benchmark Profit’ of the trading period. Additional ‘Day’ 

and ‘Zoom’ buttons allow further analysis by comparing the equity chart to short and long averages or 

analyzing the individual performance by day. Control buttons at the bottom of this module let you reset 

or save all the data from the Strategy Analysis List (C) to a .csv file. 

B

 

A

 

D

 

C

 

Symbol Linked 

Trading App Chart Window + Strategy: -P1 Strategy Architect Strategy 
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Installation 

 

The P1 Strategy Architect should install directly from the installation file you received. Additionally, you 

should manually create a folder to save your P1 Strategy search results. To install the P1 Strategy 

Architect, please follow the steps below: 

 

1. Create a folder named “P1 Data Folder” on the C drive: C:\P1 Data Folder\ 

 

 

 

 

 

 

 

2. Open TradeStation and install the .ELD file “P1 Strategy Architect….” by double-clicking the EL 

icon. This should open the Import Wizard and autoload all the P1 functions, strategies, and 

trading app into TradeStation. Click “Select All” and “Finish” when prompted. The following P1 

applications should now be installed: 

a. -P1 Strategy Architect [Trading App] 

b. -P1 Strategy Architect [Strategy] 

c. -P1 Strategy [Strategy] 

 

3. Create a new workspace within TradeStation: File > Workspaces > New Workspace 

 

4. Open the P1 Strategy Architect trading app by going to the App section and selecting the icon for 

P1 Strategy Architect. Note: the icons may appear in a different order. 

 

 

 

 

 

 

 

 

 

 

5. Open a new Chart Analysis window by going to the App section and selecting the Chart Analysis 

icon.  

 

6. Install “-P1 Strategy Architect” onto a chart. With the chart in focus, go to Studies > Add Strategy 

> Select “-P1 Strategy Architect” > click “OK” > click “OK”. A blank Selected Performance Module 

(SPM) should appear on the right-hand side of the chart. If the SPM does not appear initially, you 

might need to load more data onto your chart. 

 

7. Symbol link the P1 App to the chart by clicking the symbol link button in the upper right corner of 

both the app and Chart Analysis Window. The color of both symbol link buttons should match. 

 

 

  



7 P1 Strategy Architect User Guide 

P1 Strategy 

 

The P1 Strategy Architect suite includes three separate components:  

 

 

1. -P1 Strategy Architect [Type of study: Trading App]  

 

2. -P1 Strategy Architect [Type of study: Strategy] 

 

3. -P1 Strategy [Type of study: Strategy] 

 

 

The core is the stand-alone “-P1 Strategy” that works on any chart. It should be noted that this is 

different from the “-P1 Strategy Architect,” which is also a strategy but can only be used in combination 

with the P1 Trading App for strategy searches (described in the section P1 Architect). The stand-alone “-

P1 Strategy” acts like a chameleon and changes its trade logic depending on 19 individual input 

parameters. Without the proper parameters, this strategy will not provide any type of trading advantage.  

 

The intent of the “-P1 Strategy” is a simplified version of the strategy that can be used as follows: 

• A P1 Architect Search identifies the optimal input parameters; and 

• The inputs from the search go into the stand-alone strategy for additional testing and possible 

trade automation.  

• The “P1 Strategy” solidifies the outcome of the P1 Strategy Architect searches and outputs a 

simplified strategy you can use for sim trading, live trading, or further analysis.  

 

All strategy searches with the P1 Strategy Architect use the same input parameters as the stand-alone 

strategy. In fact, the input parameters are the main output from a strategy search. These input 

parameters define exactly how the strategy will trade and interact with the market. Different input 

parameters allow the strategy to vary the entry logic, money management, and trade exits to maximize 

the overall fitness of the system. While you can open a fresh chart, add the stand-alone “-P1 Strategy,” 

and optimize the inputs independently, this may not provide the same level of analysis available through 

a P1 Strategy Architect search.  

 

 

The “-P1 Strategy” can be added to a chart from a 

Chart Analysis Window: go to Studies > Add 

Strategy > Select “-P1 Strategy” > click “OK” > click 

“OK”. 

 
 

The “-P1 Strategy” inputs can be viewed or changed 

within a Chart Analysis Window: go to Studies > Edit 

Strategy > Click “Customize” button > Select 

“Inputs” tab on right.  

 

  

Must be linked together; used in combination for 

strategy searches 

Stand-alone strategy; used for 

more simplified trading 
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Input Descriptions 

 

 

Opt Settings  Range Description 

WaveShape_1 1 to 20 Defines the shape of wave #1 

WaveLength_1 2 to 256 Defines the wavelength of wave #1 

WaveShape_2 1 to 20 Defines the shape of wave #2 

WaveLength_2 2 to 256 Defines the wavelength of wave #2 

FilterCutoff -256 to 256 Sets the filter cutoff range 

FilterOperator.0.1 0 or 1 0 = disables wave filter 

1 = enables wave filter 

 

 

Money Management Range Description 

ProfitRatio 1 to 20 Establishes a profit target multiple of StopLossAmount 

ExitMode.0.1.2 0 to 2 0 = Exits only on stoploss or profit target 

1 = Allows trades to stop and reverse (SAR) 

2 = Allows trades to exit on opposite signal 

StopLossAmount 0 to 99999 Dollar amount of Stoploss based on minimum trade unit; 

minimum trade unit = 1 contract for futures, or 100 shares for 

equities/EFTs 

 

 

Additional Filters Range Description 

LongShortOrBoth.1.2.3 1 to 3 1 = Trades are entered as either Long (Buy) or Short (Sell) 

2 = Trades taken only in Long (Buy) direction 

3 = Trades taken only in Short (Sell) direction 

DayOrSwingTrade.1.2 1 to 2 1 = Day Trade Mode (all trades close by end of session) 

2 = Swing Trade Mode (trades held over multiple days) 

MaxTradesPerDay 1 to 20 Defines the maximum number of trades taken per day 

Monday_Trade 0 or 1 0 = No trades on Mondays  

1 = OK to trade on Mondays 

Tuesday_Trade 0 or 1 0 = No trades on Tuesdays  

1 = OK to trade on Tuesdays 

Wednesday_Trade 0 or 1 0 = No trades on Wednesdays  

1 = OK to trade on Wednesdays 

Thursday_Trade 0 or 1 0 = No trades on Thursdays  

1 = OK to trade on Thursdays 

Friday_Trade 0 or 1 0 = No trades on Fridays  

1 = OK to trade on Fridays 

IntradayStartTime 0000 to 2359 Time of day to start trading in 24H format (0830 = 8:30am) 

IntradayEndTime 0000 to 2359 Time of day to stop trading in 24H format (1600 = 4:00pm) 
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P1 Architect  

  

This section outlines the elements of a P1 Strategy Architect search. Please refer to the section: 

Installation to set up a workspace with the P1 Trading Architect Trading App and Strategy. The P1 

Architect workspace should appear as in the diagram above. Notice that no data appears in the Selected 

Performance Module or sub charts because a search has not yet been completed. Also, note that the 

green symbol link buttons appear on both the Chart Analysis Window and the search app. 

 

  

 The next step is to make sure the P1 Architect strategy 

search app is reading the data from the chart correctly. 

Check the top left portion of the app to confirm the Symbol, 

Chart Interval, and Data Range match those of the chart. If 

these fields are not updating or are blank, click the “Refresh” 

button in the upper part of the form.  

 

Click the Refresh button when restarting a search or 

changing the symbol data settings. In general, it’s good 

practice to click Refresh and check the data before starting 

any new search. 

 

 

 

 

 

 

 

  

Steps to setting up a new search 

 

1. Click Clear List button 

2. Click Clear Strategy button 

3. Load new data into the Chart Analysis Window 

4. Click Refresh button  
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Chart Analysis Window  

 

Define WHAT to trade – Begin by updating the Chart Analysis 

Window with the symbol, interval, and amount of historical data 

to build the strategy. Please note, it takes at least 600 bars of 

data for the P1 architect to process data correctly.  

 

Important: It is recommended to set the Time Zone to 

“Exchange.” This allows the search to work over multiple 

international markets without needing to adjust for time shifts.  

 

 

From within the Chart Analysis Window: go to Data > Edit Symbol, 

update the settings and press “OK” when done.  

 

 

 

 

Strategy Options 

 

Define WHEN to Trade – The Strategy Options section of the P1 App provides several checkboxes and 

dropdown menus to define different styles of trading. 

  

• Strategy Type: day trade, swing trade, or stop-and-reverse (always in a 

trade) 

• Trade Direction: long, short, or long & short 

• Maximum Trade Risk: specifies the maximum dollar risk for a 

minimum trade unit. A minimum trade unit is defined as 1 contract for 

futures, or 100 shares for equities/EFTs.  

• Intraday Start and End Times: values are in 24-hour format (e.g., 

1600 = 4:00pm) and are active only when in Day Trade mode. 

• Day of week checkboxes: let you choose the days for trading. When 

unchecked, the strategy search skips that trading day in its algorithm.  

 

 

Search Filters 

 

Define WHY take a Trade – The Search Filters section defines the performance criteria for a strategy.  

 

• Fitness Function: defines the primary metric the AI uses to search for 

strategy candidates. Options include net profit, TS index, expectancy, 

pessimistic rate of return, and perfect profit.   

• Profit Factor, Min Trade Number, Max Drawdown, and Minimum 

Average Trade values let you drill down on the exact performance you 

want to see within a strategy. 

• Data Selection: sliders let you choose how much out-of-sample data 

(OOS) to omit from the testing process. This can be a helpful tactic to 

avoid curve fitting. The location of the sliders represents OOS data either 

at the beginning or the end of the data collection.  
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AI Settings 

 

Define HOW to Search – The AI section gives you control over the genetic search. When “Customize 

Genetic Operator Settings” is unchecked, the app will specify a standard search algorithm. 

 

 Checking the “Customize Genetic Operator Settings” checkbox allows 

access to all the operators for the genetic search algorithm. A full 

description of the genetic operators appears in the Appendix B at the 

end of this manual. Here is a synopsis of the most critical operators: 

• Search Iterations: sets the number of times the search will run the 

entire algorithm. 

• Population Size: defines the number of ‘random’ selections of input 

parameters used within each search generation. 

• Generations: the successful pairing of a group of input parameters 

that maximizes the fitness function at the end of the Population Size 

run. At the end of each generation, those successful inputs remain 

constant throughout the remainder of the search. 

 

Search Buttons 

 

Once you establish the parameters for the search, the Search buttons 

allow the following actions: 

 

• Start Search: begins a search and starts the AI algorithm.  

• End Search: ends the current search and updates the chart with the best current results. 

• Clear List: clears the list of search results from the Strategy Analysis List (click this button before 

starting a new search to clear the memory buffer). 

 

Note: there may be a slight delay after you click the Start Search button. This is normal and depends on 

computer speed and the amount of data being analyzed.  

Search Progress 

 

This section of the form shows the progress of the current search. 

The green horizontal progress bar provides a status display, while 

the chart at the bottom shows a graphical representation of the 

current search. The y-axis of the chart represents the currently 

selected fitness function (described in section: AI Settings). The chart 

should stairstep upwards as the AI finds increasingly better strategy 

results. Once the chart plateaus, this is a sign that the strategy 

search may be coming to an end, as no better values are found.  

 

When using AI Settings: Search Iteration values setting greater than 

1, multiple lines will appear noting the results of each individual 

search iteration. With multiple iterations, the bracketed fitness 

function value in the text above the chart displays the best fitness for 

all iterations.  

 

Below the chart is the textbox “Save Results for WFO Analysis.” When checked, it saves the entire search 

file, which the TradeStation Walk Forward Optimizer can access. This is recommended as an additional 

method of avoiding curve fitting when developing a system.  

Total Number of Search Tests = Search Iterations * Population Size * Generations 
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Evaluating Strategies 
  

Once a search has completed, the data from the best strategies are sent to the Chart Analysis Window, 

where the Strategy Analysis List and Selected Performance Module become populated (as shown above). 

Not all searches yield results, however. A search may not return any strategies if it didn’t meet the 

criteria. In this case, an info box appears notifying you of the bad news. When this happens, you can 

change the data interval or adjust the search filters to allow for a more inclusive search.  

 

Strategy Analysis List 

 

The Strategy Analysis List is the 

first place to review strategies 

generated by the search. Click on 

any of the column headings to 

sort strategies by that field. For 

instance, if you want to sort by 

highest profit factor, click the 

“Profit Factor” heading.  

 

After sorting the columns, clicking 

the # column allows the Chart Analysis Window and the Selected Performance Module to update with the 

selected strategy. The row highlighted in yellow indicates which strategy is currently selected. Once you 

select a row, you can review individual trades on the Chart Analysis Window.  

 

Note: This list will not automatically save when closing and reopening a TradeStation workspace.   

To save this list, click the “Write to File” button on the Select Performance Module to output it to a .csv 

file.  

 

  

Click Here to Update Chart 

Click Here to Save List 
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Selected Performance Module 

 

The Selected Performance Module provides a consolidated 

performance report with key metrics, along with an equity 

curve that includes a benchmark comparison. The benchmark 

equity curve displays the hypothetical buy-and-hold 

performance for the same symbol and time period. When out 

of sample data (OOS) is selected from the Search Filter, the 

equity curve will color the Trained Profit (data that was 

optimized by the search) and OOS Profit (unseen data from 

the search) differently. 

 

This module has two additional analysis buttons (located just 

under the equity curve) that allow for more detailed system 

analysis:  

 

• The “Day” button displays a sub-chart of the strategy 

broken down by day.  

• The “Zoom” button displays a larger version of the 

equity curve with fast and slow averages applied. This 

can be a helpful way of determining how close a 

strategy is to a major drawdown period.   

 

 

 

 

 

 

 

 

 

 

 

 

 

The action buttons at the bottom of the chart allow for the following functions:  

 

 

 

 

 

• Write to File: saves the current strategy list from the Strategy Analysis List to a .csv file in a folder 

named “P1 Data Folder” on your computer’s C drive.  

• Update OOS Corr: Updates the top 10 out-of-sample correlation values withing the Strategy 

Analysis List. This is recommended to be done before using the “Write to File” button.  

• Clear Strategy: removes the current strategy from the chart (click when setting up a new search). 

• Unclutter Chart: removes the Strategy Analysis List and the Selected Performance Module to make 

the chart more readable. Once these modules have been removed, they can easily be returned by 

clicking the upper left corner of the chart.  

• Load: This allows you to review and load strategies that have been saved from previous searches 

(when they had been saved using “Write to File” button). All previous searches can be seen from 

the dropdown list. Clicking on the desired file will enable the button. 
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Chart Analysis Window 

 
The Chart Analysis Window displays all the trades from the currently selected strategy. The Input 

parameters for the current strategy are displayed in the upper left corner of the chart. Clicking this list 

displays a more detailed view of P1 Strategy Input Values along with their names. A second click in the 

upper left corner of the chart makes the larger list disappear.  

 

You may find it easier to view the chart without the other modules. You can use the “Chart Unclutter” 

button to remove these; clicking the upper left corner of the chart brings them back. 

 

Once a strategy has been screened and selected on the chart, you can save it within a workspace (.tsw 

file). To save a workspace: go to File > Workspace > Save Workspace as… then give it a recognizable 

name (e.g., P1_ES_15min_DT_9-30-22). Upon reopening the workspace, the previously selected strategy 

will remain. However, the list will not be saved within the workspace (this can be saved to a separate file 

using the “Write to File” button).  
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Appendix A – Fitness Functions 
  

 

 

Fitness Function  Description 

Net Profit How much the strategy made or lost. 

TS Index A fitness function that maximizes the Net Profit and Winners while minimizing 

Intraday Drawdown. It calculates the Net Profit * NumWinTrades / AbsValue 

(Max. Intraday Drawdown). 

Expectancy  
A fitness function that measures Expectancy x Opportunity. Based on a 

calculation by Van K. Tharp. 

Expectancy = (AW x PW + AL x PL) / |AL| 

  (expected profit per amount risked) 

    AW = average winning trade (excluding largest win) 

    PW = probability of winning: PW = (Winning trades-1) / NST 

    AL = average losing trade (negative, excluding scratch losses) 

    |AL| = absolute value of AL 

    PL = probability of losing (PL = {non-scratch losses} / NST) 

Opportunity = NST / StudyDays 

     NST = {total trades} - {scratch trades} - 1 

       *In other words, NST = non-scratch trades during the period under test 

(a scratch trade loses commission+slippage or less) minus 1 

    StudyDays = calendar days of history being tested 

Pessimistic ROR 
A fitness function that represents a very conservative value for Return on 

Capital (ROC). It calculates the AvgWin*(NumWinTrades) - 

SquareRoot(NumWinTrades))+AvgLoss*(NumLossTrades + SquareRoot 

(NumLossTrades))) / Capital.  

NumWinTrades = number of winning trades, NumLossTrades = number of 

losing trades, AvgWin = GrossProf/NumWinTrades, and AvgLoss = 

GrossLoss/NumLossTrades. 

Perfect Profit Calculates the correlation of the actual equity curve vs. a "perfect" curve as if 

the strategy were able to buy every bottom and sell every top. The genetic 

optimizer targets an equity curve that closely matches a "perfect" equity 

curve. 
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Appendix B – Genetic Operators 
  

 

Genetic Operator  Description 

Search iterations The number of total searches that will be completed to create the final 

Strategy Analysis List. Each iteration is a separate search subroutine that will 

not have any knowledge of the previous searches. 

Population size The number of input parameter combinations that will be subject to the 

genetic selection process. After the specified generations, the outstanding 

population group is understood as being of improved fitness due to the 

natural selection of the genetic algorithm. 

Generations The number of iterations the genetic algorithm will run until it arrives at the 

strongest outcome. 

Mutation rate The random rate of modification of single inputs within the overall input 

group after each generation. Mutation is used to find a new group of input 

parameters to replace the 'weak' ones. 

Crossover rate The rate that specifies how close the replacement input parameters in the 

overall parameter group are picked after each generation. Crossover is used 

to find new input values to replace the 'weak' ones. 

Stress Test Size  

Stress increment The percentage that the parameters will be stressed either upwards or 

downwards. 

End Search This will define the number of unchanged search generations that are 

required to end a search. In other words, if the population fitness of a search 

does not improve for x number of generations, the search will terminate.  
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Disclaimer 

  

All content contained in the P1Strat and PowerZone Trading, LLC (www.powerzonetrading.com) websites, 

and all videos, literature, products, and services (including but not limited to consulting and programming 

services) are for educational purposes only. PowerZone Trading makes no guarantee that you will 

become a successful trader, even with the best education, tools, and guidance. PowerZone Trading does 

not make any trading recommendations, and nothing should be construed as such. You are responsible 

for all trading activities in which you engage, including any resulting losses. You should consult your 

broker or financial advisor before placing any trade. PowerZone Trading assumes no responsibility for 

your trading and investment activities or results. By accessing the P1Strat and PowerZone Trading 

website(s) and/or by purchasing any PowerZone Trading product or service, you agree not to hold 

PowerZone Trading, LLC, its managing members, and/or its affiliates liable for any loss or damage arising 

either directly or indirectly from such action.  

 

Required USA Government Disclaimers:  Futures and Options trading has large potential rewards, but 

also large potential risk. You must be aware of the risks and be willing to accept them in order to invest 

in the futures and options markets. Don't trade with money you can't afford to lose. This is neither a 

solicitation nor an offer to Buy/Sell futures or options. No representation is being made that any account 

will or is likely to achieve profits or losses similar to those discussed on this web site or during 

instructional sessions. The past performance of any trading system or methodology is not necessarily 

indicative of future results.   

 

CFTC RULE 4.41 - HYPOTHETICAL OR SIMULATED PERFORMANCE RESULTS HAVE CERTAIN INHERENT 

LIMITATIONS. UNLIKE AN ACTUAL PERFORMANCE RECORD, SIMULATED RESULTS DO NOT REPRESENT 

ACTUAL TRADING. ALSO, SINCE THE TRADES HAVE NOT BEEN ACTUALLY EXECUTED, THE RESULTS MAY 

HAVE UNDER-OR-OVER COMPENSATED FOR THE IMPACT, IF ANY, OF CERTAIN MARKET FACTORS, SUCH 

AS LACK OF LIQUIDITY. SIMULATED TRADING PROGRAMS IN GENERAL ARE ALSO SUBJECT TO THE FACT 

THAT THEY ARE DESIGNED WITH THE BENEFIT OF HINDSIGHT. NO REPRESENTATION IS BEING MADE 

THAT ANY ACCOUNT WILL OR IS LIKELY TO ACHIEVE PROFIT OR LOSSES SIMILAR TO THOSE SHOWN. 
 

http://www.powerzonetrading.com/

